
За уређивање слике често се користе слојеви (Layers). 

Слојеви су делови слике који се користе при обради дигиталних слика за одвајање њених 

елемената. 

Коришћењем слојева можемо да правимо слике из више делова, од којих се на сваком делу 

може манипулисати без утицаја на било који други део слике. Слојеви су сложени један на 

други. Доњи слој је позадина слике, а компоненте у првом плану слике се налазе изнад ње. 

Као и у претходним разредима обраду слика ћемо радити у програму Gimp 2.  

Картица Layers (Слојеви) налази се у горњем десном делу прозора програма Gimp 2. 

У оквиру ње можемо да креирамо нове слојеве, копирамо или бришемо постојеће, 

приказујемо их или сакривамо, повезујемо, мењамо им провидност или бирамо начин 

мешања. 

На доњој слици је приказана картица Layers у програму Gimp 2: 

1 – Начин мешања слојева (Mode) 2 – Непровидност (Opacity) 3 – Закључавање слојева 4 – 

Палета слојева 5 – Палета дугмића за рад са слојевима 

Уколико картица Layers није приказана приликом покретања програма Gimp 2 можемо је 

приказати комбинацијом тастера Ctrl + L. 

Додавање и брисање слојева 

Да бисмо креирали нови слој потребно је да кликнемо на Layer → New Layer, или 

комбинацијом тастера Shift + Ctrl + L или кликом на прво дугме у дну палете Layers . 

Отвориће се прозор у коме можемо да именујемо слој, подесимо његову резолуцију и 

означимо да ли ће бити провидан или испуњен бојом. 

Притиском на дугме OK додајемо слој у палету слојева. 

На дну палете слојева, поред дугмета за додавање новог слоја, налазе се редом: 

1. дугме за креирање нове групе слојева; 

2. дугме за померање активног слоја на једно место више у палети; 

3. дугме за померање активног слоја за једно место ниже у палети; 

4. дугме за креирање дупликата слоја; 

5. дугме за усидравање и дугме за брисање слоја. 

Да би слој био видљив, активирамо га кликом на његов назив у палети слојева. 
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Кликом на дугме за брисање слоја  можемо да избришемо само активан слој. Све измене 

можемо да вршимо само на активном слоју. Двоструким кликом на назив слоја можемо да 

изменимо његов назив тако што га откуцамо, а затим притиснемо тастер Enter. 

Приказивање и сакривање слоја 

У картици Layers главни део чини Палета слојева у којој се налази листа свих слојева. 

Испред слојева могу бити видљиве (укључене) две иконице  (око и ланац). 

Слој је видљив (приказан) ако је иконица ока приказана испред слоја. У случају да иконица око 

није видљива и слој неће бити приказан у прозору за приказ слике. 

Иконица ланца означава везу између слојева. Слојеви су повезани и можемо их заједно 

померати када је иконица ланца видљива. Померање слојева вршимо коришћењем алата 

Move . 

 

Подешавање непровидности, закључавање и стапање слојева 

На почетку, сваки слој је дефинисан као непровидан, тачније опција Opacity је подешена на 

100%. За сваки слој се засебно подешава да ли ће се мењати непровидност слоја или не. 

Кликом на стрелице  мењамо провидност 

слоја. 

У програму за обраду слике могуће је закључати слојеве како бисмо спречили измену његовог 

садржаја. 

Опција Lock (Закључај)  штити слојеве од 

измена на два начина: 

 кликом на иконицу четкице закључамо све пикселе на слоју; 

 кликом на иконицу провидног слоја закључавамо само провидне пикселе на слоју. 

 

У програму GIMP 2 могуће је стапање (мешање) слојева. То је опција којом се дефинише на који 

ће се начин пиксели на доњем слоју измешати (стопити) са пикселима који се налазе на 

горњем слоју. 

На почетку, стапање пиксела слојева је подешено на Normal, чиме је обезбеђено да горњи слој 

у потпуности прекрива доњи (ако је непровидност подешена на 100%). 
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Кликом на стрелицу поред опције Mode (Начин мешања) добијамо листу свих начина стапања 

(мешања) слојева. 

 

Од горе приказаних начина мешања слојева неке можемо да користимо за: 

 потамњивање слике (Multiply, Overlay); 

 рад са црно белим фотографијама (Dodge); 

 отклањање ефекта црвених очију (Hue) који се понекад јавља приликом фотографисања 

дигиталним уређајима. 

 

Растеризација слоја 

У појединим програмима за обраду растерске графике, као што је програм Gimp 2, текст је 

представљен векторском графиком. Повећањем величине слова не долази до губитка 

квалитета слике. 

Векторски слој са текстом трансформишемо у растерски тако што кликнемо десним кликом на 

текстулани слој и појавиће се помоћни мени. У помоћном менију треба да одаберемо опцију 

Discard Text information (Одбаци текстуалне информације) којом се векторски текстуални слој 

претворити у растерски. Овај процес називамо растеризовање.  

Растеризација је процес трансформације (конвертовања) геометријских објеката у њихову 

растерску верзију, тачније репрезентацију помоћу пиксела. 
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Након процеса растеризације, увећавањем слова дошло би до губитка квалитета слике. 

Поступком чувања (експортовања) слике из формата програма Gimp2 (xcf) у неки од формата 

растерских графичких датотека (jpg, png, bmp…) престаје могућност измене слојева. 

 

Да бисмо уредили одређени део слике у програму Gimp 2 постоји више алатки помоћу којих 

то можемо да урадимо. 

Алатке за означавање (селектовање) жељеног дела слике налазе се у Toolbox (1), а видљиве су 

и у оквиру менија Tools → Selection Tools (2). 

 

Део слике селектујемо употребом алатки за правоугаону , елипсоидну , и селекцију 

слободним избором  или издвајањем пиксела који имају сличне особине (суседне области 

сличне боје , области исте боје на целој слици ). Кликом на једну од наведених 

алатки, отвара се простор у коме је могуће подесити њена својства. 

Најважнија својства алатке за избор правоугаоне селекције су: 

1. Mode – преклапање селекције (Прво дугме активира режим у коме се креирањем нове 

селекције уклања претходна, док друго дугме активира режим у коме се креирањем 

нове селекције задржава претходна); 

2. Feather edges – фини прелаз између селектованог и неселектованог дела слике; 

3. Rounded corners - Заобљене ивице;  

4. Expand from Center - Рашири из средишта. 
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Селекцију у облику правоугаоника исцртавамо тако што одаберемо алатку Rectangle Select 

Tool  и, држећи притиснут леви тастер миша, развучемо правоугаоник. 

Да бисмо извршили квадратну селекцију држимо притиснут тастер Shift или подешавамо 

својства  којим се задржава однос ширине и висине на 1:1 

што значи да ће нам бити иста ширина и дужина селекције. 

Овалну селекцију исцртавамо тако што одаберемо алатку Ellipse Select Tool  и, држећи 

притиснут леви тастер миша, развучемо овални облик. Круг исцртавамо држећи притиснут 

тастер Shift или подешавањем својства задржавања односа ширине и висине 1:1. 

Селекцију неправилног облика исртавамо коришћењем алатке Free Select Tool  (ласо). 

Селекцију исцртавамо тако што курсор поставимо на део слике који желимо да селектујемо. 

Држимо притиснут леви тастер миша и исцртавамо жељени облик. Да би облик био затворен, 

процес селектовања морамо да завршимо у тачки из које смо га започели. 

Да бисмо селектовали суседну област или објекат сличне боје користимо алатку Fuzzy Select 

Tool . Када кликнемо на неку област или објекат, пиксели који имају сличну вредност боје 

биће такође селектовани. 

Да бисмо селектовали све области или предмете исте боје можемо да користимо алатку Select 

by Color Tool . Када кликнемо на неку област или објекат, сви пиксели који имају исте 

вредност боје биће селектовани. 
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Промена нивоа обојености, осветљености и контраста 

У програмима за обраду слике могуће је да извршимо додатне корекције на слици као што су 

промене нивоа осветљености, контраста или обојености. 

У оквиру менија Colors можемо да подесимо: 

 Color Balance - равнотеже боја (подешавање тамних или светлијих делова слике); 

 Hue-Saturation - нијанси - засићеност; 

 Colorize - обојености; 

 Brightness-Contrast - осветљење, односно контраст. 

 

Кликом на Color Balance отвара се помоћни мени у коме можемо да променимо тамне 

(Shadows), средње (Midtones) или светле делове (Highlights) слике, те да, померањем клизача, 

подесимо нивое боја (Cyan, Magenta, Yellow). 
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Кликом на опцију Brightness-Contrast отвара се прозор у коме померањем клизача можемо 

подесити осветљеност Brightness и/или контраст Contrast. 

 

Филтери 

Филтерe користимо за постизање различитих ефеката на слици као што је изоштравање или 

замућивање фотографије. Они се могу применити на слоју или селекцији. 

Филтерима приступамо кроз мени Filters. 

 

https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L75S10.png
https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L75S11.png
https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L75S12.png


Најчешће се користе следећи филтери: 

- Blur – скуп филтера којим се замућује цела или део слике. - Enhance – скуп филтера помоћу 

кога се врши изоштравање слике, отклањање мрља, црвенила очију… - Distorts – скуп филтера 

са ефектима мозаика, ветра, таласа,… - Artistic – скуп филтера помоћу којих се ствара уметничке 

ефекте као што је изглед уља на платну, витража… 

Када кликнемо на одабрани филтер отвара се помоћни прозор у којем можемо да видимо како 

ће изгледати слика након примене филтера, као и да изменимо додатне параметре како би 

постигли жељени резултат. Притиском на тастер OK потврђујемо примену одабраног филтера. 

 

Основне геометријске трансформације слике 

У програму Gimp 2 постоји више алатки којима можемо да извршимо трансформацију слике 

као што је ротирање, обртање или искошавање слике. Овим алаткама приступамо у Toolbox 

или кроз мени Tools → Transform Tools. 

 

Слику или делове слике можемо да трансформишемо тако што је: 

 ротирамо кликом на алатку ; 

 променимо величину кликом на алатку ; 

 искосимо кликом на алатку ; 

 променимо перспективу кликом на алатку ; 

 преокренемо кликом на алатку . 

Кликом на једну од горе наведених алатки, отвара се простор у коме је могуће подесити 

њихова својства. 

https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L75S13.png
https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L75S14.png
https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L75S15.png
https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L75S16.png
https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L75S17.png
https://petljamediastorage.blob.core.windows.net/root/Media/Default/Kursevi/OnlineNastava/7_razred_IKT_DigitalnaPismenost/L75S18.png


 

Најважнија својства су: 

- Transform – избор слоја или селекције на којој ћемо применити трансформацију; - 

Interpolation – начин на који ће пиксели који недостају на трансформисаној слици бити 

допуњени; - Show image preview – начин на који ће се промене, током трансформације 

приказивати у прозору слике. 

Поред горе наведених својстава, избором неке од алатки за трансформацију слике, могу се 

приказати и друга својства као што је Flip Type - врста/тип преокретања који може да буде 

хоризонтални (Horizontal) или вертикални (Vertical). 

 

Ротација 

Често се дешава да сликa коју сте преузели са интернета или сте је направили камером неког 

дигиталног уређаја буде погрешно оријентисана. У програму за обраду слике постоји алатка 

којом је могуће ротирати слику и поставити је онако како нам одоговара. За то ћемо користити 

алатку Rotate Tool. 

Кликом на активни слој или селектовани део слике појавиће се прозор где подешавамо: 

 угао ротације (Angle) померањем клизача или уношењем бројевне вредност и 

 центар ротације. 
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Избор потврђујемо кликом на дугме Rotate. Поред тога, слику можемо да ротирамо и тако што 

кликнемо на слој и држимо притиснут леви тастер миша док га померамо у смеру жељене 

ротације. 

Искошавање 

Да бисмо искосили слику по хоризонтали или вертикали можемо користити алатку Shear Tool. 

Кликом на дату алатку отвара се прозор у коме се вредности уносе кликом на стрелице или 

конкретном уносом бројчане вредности. Избор потврђујемо кликом на дугме Shear. 

 

Преокретање 

Слику или део слике можемо да преокренемо по хоризонтали или вертикали помоћу алатке 

FlipTool. 

Аутоматска обрада већег броја дигиталних слика 

Ако желимо да у исто време променимо име или величину свих слика које се налазе у 

фасцикли, то је у програму за обраду слике могуће коришћењем програмских додатака. Један 

од таквих додатака је dbp.exe који омогућава аутоматску обраду (промена имена, величине,…) 

више дигиталних слика. 

Додатак можемо преузети са овог линка. Да би инсталирали додатак потребно је да га 

ископирамо у фасиклу plug-ins програма Gimp 2. Место фасцикле plug-ins зависи од тога где је 

на твом рачунару инсталиран програм Gimp 2. 
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Након покретања програма Gimp 2, из менија Filters можемо да покренемо додатак Batch 

Proces. 

 

Отвара се прозор у оквиру кога кликом на Аdd Files додамо жељене слике и одабирамо акцију 

коју желимо на њих да применимо. 
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